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1. Introduction  

 
Power Control is a program specially designed to control and 

supervise the energy consumption of an installation. 
 
It allows to configure power calendars, create installation loads and loads 
groups, define connection timetables and loads disconnection, display real 
time graphs of the consumption progress and loads connection and 
disconnection. The program allows to simulate it before we do the final 
supervision. Moreover, we can export data and also, we can do a 
consumption report of specified period. 

  

2. Menus 
 

When we open Power Control, presentation window appears. If we 
click over it, the main screen will appear. There, we’ll be able to configure the 
program. 
 
The available options in the program menu are:  

•  File 
•  Options 
•  Graph 
•  Information 

 

2.1. File 
 
In File menu option, we can select or open the work path where there 

are all the configuration files of the program and the installation we want to 
supervise. 

 
The available options in File menu are: 

2.1.1. New 
It allows selecting the new work path. Once we have selected it, the program 
will create all the configuration files. If the files are already created, it will 
delete them and it will create files without information. 
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2.1.2. Open 
It allows selecting a work path where the files of a previous installation are. 
 

 

2.1.3. Language 
It allows choosing the program language. The available options are: Spanish 
and English. 
 

 
 

2.1.4. Exit 
It ends the program execution. 
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2.2. Options 
 

In the Options menu option, we can modify the operation parameters 
of the program, unless select the groups and loads configuration screen or 
the simulation or supervision screens of the installation. 
 
The available options in Options menu are: 

2.2.1. Parameters 
Appears a window with several options to configure the program operation. 

 

 
 
- Parameters 

- Integration period: Time in minutes where the values will be 
integrated. 

- KWh by pulse: Consumed energy value by pulse. 
- External synchrony pulse: Indicates what kind of pulse we want. 

External pulse or controlled for CA-4 pulse. 
 

- Window type: Indicates the type of work mode. The type of window 
we can select, can be: 
- Fixed: When there is a synchrony pulse, the control period will 

reboot. 
 

 
 

- Sliding: It will give to each integration window a synchrony 
pulse according to the last control period. 
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- Control: It will select the parameter we want to control in the 
installation. 
- KW (Active power) 
- KVA (Aparent power) 

  
- Sliding window parameters: It will be enabled if we select sliding as 

type of window. 
- Integration time: It’s the period where the programmed value 

will be integrated. 
- Exceed: It’s the value (percentage) that increases the allowed 

consumption in each integration window (0 - 30%) 
 

- Simulation parameters: They are the parameters that will be used 
in a simulation of the installation. 
- No controlled load: It’s the power consumption value that the 

controller doesn’t control. 
- Variation factor: It’s the value (percentage) that modifies the 

power consumption to obtain a no constant consumption in the 
simulation (0 - 20%). 

 
- Clock: It reads the internal clock of CA-4 that is connected to the 

PC. Then, a screen appears, there, we can modify date and time 
and send them to the device. If we check Syncrhonize clock with 
synchrony pulse option, the internal clock will be synchronized 
with the external pulse. 
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- Historics: A screen where we can select the parameters that will be 
saved to historics file, appears. 

 

 
 

- Calendar: It allows configuring the maximum contracted power 
calendar. We can configure maximum 8 types of days with eight 
types of different target values. 

 

 
 

- Advanced: A screen where we can configure delay time between 
actions and reconnection. 
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- Delay between actions: Time in seconds (2 - 250) to take a 
decision about the loads control. 

- Reconnection time: Time which won’t be reconnected more 
loads at the end of the period (0 - 250). 

 

 
 

- Alarms: A screen where we can enable a control alarm appears. 
This alarm will be activated where the controller hasn’t got more 
loads to control and the real value is over the demand value. 

 

 
 

When the alarm is activated, the following button appears:  
 

 
 

in the up-right side of the installation windows, in the two modes 
(simulation and supervision). The alarm will be disabled if we 
click over the button or if we wait the stablished time in the 
dialog box. If the time is 0, we must click over the button to stop 
it. 

 
 

- Password: It allows locking the window. Once we have introduced 
the code, we won’t be able to do any action on the program. 
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2.2.2. Configure 
It allows configuring the loads groups and only the loads. 
 

� Groups: We’ll be able to add new groups, modify existing groups or 
delete previous groups. Moreover, we’ll be able to add or delete loads 
from a group. 
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� Groups: A list with configured groups appears. The actions will be 

able to do are:  
 

♦  Add: It allows creating a new group. 
 

 
 

- Name: Word to identify the loads group. 
- Disconnection sequence 

- FIFO: First in, first out. The order of the loads doesn’t 
influence the first time, later, it depends on the load we 
have to disconnect. 

- LIFO: Last in, first out, normal stack. 
- Disconnection order: There is an order to disconnect the 

loads. 
 

♦  Modify: We can modify the data of selected group. To confirm 
the changes, we have to click over Accept button. To cancel 
the changes, we have to click over Cancel. 

 
♦  Delete: Selected group will be deleted. A message to confirm 

the group removal will appear. If we press Yes, the group will 
be deleted from the list. 

 
� Group loads: A list with all the loads of selected group appears. 

The actions will be able to do over the loads, are: 
 

♦  Add: A window with all the loads isn’t of the selected group but 
they can be in other groups, appears. We can select and 
change the group clicking over Accept. 
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♦  Delete: It allows deleting the loads from the group that we have 
selected previously. A message to confirm the loads removal 
will appear. If we press Yes, the selected loads will be deleted 
from the list. 

 
� Loads: We’ll be able to add new loads, modify existing loads or delete 

previous loads. The following screen will appear: 
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� Add: It allows adding new loads to the installation. The following 
screen will appear: 

 

 
 

- Loads: 
- Name: Load name 
- Identification: Name to identify the load in the installation. 
- Power: Maximum power of the load. 
- Variation factor: Value (percentage) that modifies the power 

consumption to obtain a no constant consumption in the 
simulation (0% – 20%). 

 
- Time: 

- Maximum disconnected: Maximum time that the controller may 
has a load disconnected. 

- Minimum disconnected: Minimum time that the controller 
should has a load disconnected. 

- Minimum connected: Minimum time that the controller should 
has a load connected. 

 
- Input: CA-4 and Mr-3 inputs allowed software to know load status. 

The input function is  to know if load is activated or stopped.  
 

- Output: Software use CA-4 and Mr-3 outputs to active or stop 
loads.  

 
- Group: Group selection where we can find a load. 

 
- Order: Load priority in the loads group to verify the load and unload 

times. 
 

- Address 
- MR3: Expansion peripheral address (1 – 42). 
- Position in MR3: Position where the load is connected (1- 3). 
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- Calendar: Calendar selection to the connection and disconnection 

of the load. About more information, see Loads calendar section. 
 

� Modify: It allows modifying the selected load data in the loads list. 
 

� Delete: It allows deleting a load from the loads list. 

2.2.3. Installation simulation 
It allows doing a simulation with the groups, loads and parameters that we 
have configured in the program. 
 

� Simulation: Will appear a list with all the configured loads, a simulation 
parameters and the consumption evolution in real time, graphically. To 
start the installation we must click over OFF image and if we want to 
stop it, we must click over ON image. The following screen will 
appear: 

 

 
 

- Simulation parameters 
- Date and Time: Will appear the date and time of the simulation 

in real time. We can modify and introduce other date and time. 
- Speed: Number of iterations by second. It’s the load simulation 

speed. 
- Maximum power: When we click over the button on the right, 

the target value will be the same that the main calendar. If it 
isn’t pressed, we’ll be able to introduce a target value. 

- Average power: It’s the average power value of the installation. 
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- ON/OFF button: It starts or stops the installation simulation. 
 

In the list where there are the configured loads in the system, if we right-
click, a menu will appear and there, we’ll be able to select the loads we 
want to display: 
 

 
 
- All: All the loads 
- Active: Active loads 
- Inactive: Inactive loads 
- Disconnected: Disconnected loads 

 
 
Also, if we right-click over a load, a menu like the following menu will 
appear: 
 

 
 
- Force active: The controller won’t be able to disconnect the load 
- Force disconnect: The controller will disconnect the load but it won’t 

be able to connect again 
- Free: It will remove any forced status in a load to continue a normal 

status operation 
 
 
� Historics: An installation simulation historic will be displayed. The 

following screen will appear if we click over Historics folder: 
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When we do the program simulation, it creates a STD file where it saves 
the values are registering. This file saves the data each month. The 
graphs and events representation are data that the program saves in this 
file. 

 
In the previous screen, appears the name of the file where the data is 
stored. The initial and final date of the file is displayed. In the graph, there 
are the simulation consumption (KWh), the target value and the average 
power of the simulation (KW avg). The time representation in the graph is 
about one day. If we click over the graph, will appear a cursor that we can 
use with the keyboard arrows to move for each graph value and we can 
display what each graph point means.  On the right side of the graph, 
there are the values of the graph and they are stored in STD file. 
 
Buttons: 
 

 Select the day we want to show in the graph or 
events table. 
 

 Go back a day in the file. 
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 Go forward a day in the file. 
 

 Show the events screen of the selected day. See 
Power Control buttons section for more information. 
 

 Upload the data with the new data of the file. 
 

 Export the data to text file or data base format. See 
Power Control buttons section for more information. 
 

 Show the energy consumption. See Power Control 
buttons section for more information. 
 
 
 
� Events: The events of the simulated installation will be displayed. The 

following screen will appear when we click over Events folder: 
 

 
 

When we do the simulation, the program creates a STD file where it 
saves the simulation values that it registers. This file saves the data 
each month. The graph and events representation are data that it 
saves into this file. 

 
In the previous screen, appears the name of the file where the data is 
stored. The initial and final date of the file is displayed. In the graph, 
there are the data connection and disconnection that we have 
selected previously. The time representation is a two hours period. If 
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we click over the graph, will appear a cursor that we can use with the 
keyboard arrows to move for each graph value and we can display the 
time of this point.  On the right of the graph, there are the values of the 
graph and they are stored in STD file. 

 
Buttons: 

 

 Select the day we want to show in the graph 
or events table. 
 

 Go back a day in the file. 
 

 Go forward a day in the file. 
 

 Select the period time we want to show in the 
graph or events table. 
 

 Go back in the time period. 
 

 Go forward in the time period. 
 

 Display the data selection screen we want to 
show in the graph. See Power Control buttons section for more 
information. 
 

 Display the load throughput screen. 
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 Display the selected day events and time period.  
See Power Control buttons section for more information. 
 

 Upload the data with the new data of the file. 

2.2.4. Installation supervision 
 It allows doing real time supervision with configured groups, loads and 
parameters of the program. It checks the controller configuration with the 
software configuration when we click over supervise mode. 
 

� Installation: A list appears with all configured loads, taken parameters 
in real time and the consumption evolution in real time, graphically.  
 
The supervision will start when the screen appears (we have 
communicated with the controller, previously) and the communications 
with the program are correct. If doesn’t exist communication with the 
controller we won’t be able to supervise the installation in real time. 
 

 
 

- Supervision parameters 
- Date and Time: The date and time of the supervision will 

appear in real time. We can modify and introduce other date 
and time. 

- Maximum power: The target value will be the calendar target 
value we have assigned in the configuration. 

- Average power: It’s the value of the average power of the 
installation. 
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- Send configuration: It sends the configuration to the controller. 
 

If we right-click over the list where the configured loads are displayed or if 
we click over the Filter button, a menu will appear, where we’ll be able to 
select the loads we want to show: 
 

 
 
- All: All active loads. 
- Active: Active loads. 
- Inactive: Inactive loads. 
- Disconnected: Disconnected loads. 

 
 

If we right-click over a load will appear a menu like this: 
 

 
 
- Force active: The controller won’t be able to disconnect the load. 
- Force disconnects: The controller will disconnect the load but it won’t 

be able to connect again. 
- Free: It will remove any forced status in a load to continue with its 

normal status 
 
 
 

� Historics: A real time historic of the installation will be displayed. If we 
click over the Historics folder, the following screen will appear: 
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When we do the supervision, the program creates a STD file where it 
saves the values it is registering. This file saves the data each month. 
The graph and events representation are data that this file contains. 
In previous screen, appears the file name where the data is stored. 
The initial and final date of the file is displayed. In the graph appear 
the simulation consumption (KWh), the target value and the average 
power of the simulation (KW avg). The representation in the time 
graph is about a whole day. If we click over the graph will appear a 
cursor that we can use with keyboard arrows to move for each value 
of the graph and we can display what each graph point means. On the 
right side of the graph appear the showed values in the graph, which 
are stored in the STD file. 
 
Buttons: 
 

 Select the day you want to display in the 
graph or events table. 
 

 Go back a day in the file. 
 

 Go forward a day in the file. 
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 Display the events screen of the selected day. See 

Power Control buttons section for more information. 
 

 Upload the data with the new data of the file. 
 

 Export the data to a text file or a data base format. 
See Power Control buttons section for more information. 
 

 Display the energy consumption. See Power 
Control buttons section for more information. 
 
 
 

� Events: The installation events will be displayed in real time. The 
following screen will appear if we click over Events folder: 
 

 
 

When we do the program supervision, the program creates a STD file 
where it saves the values are registering. This file saves the data each 
month. The graph and events representation are data that this file 
contains. 
 
In the previous screen, there is the file name where the data is stored. 
The initial and final date of the file is displayed. In the graph, there are 
the data connection and disconnection that we have selected 
previously. The time graph representation is a two hours period. If we 
click over the graph, will appear a cursor that we can use with 
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keyboard arrows to move for each graph point and also, we can use it 
to show the time of this point. 
 
Buttons: 
 

 Select the day we want to show in the graph 
or events table. 
 

 Go back a day in the file. 
 
 

 Go forward a day in the file. 
 

 Select the time period we want to show in the 
graph or events table. 
 

 Go back in the time period. 
 

 Go forward in the time period. 
 

 Display the screen of the data we want to show 
in the graph. See Power Control buttons section for more information. 
 

 Display the loads throughput screen. See Power 
Control buttons section for more information. 
 

 Display the events screen of the selected day and 
time period. See Power Control buttons section for more information. 
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 Upload the data with the new data of the file. 

2.2.5. Lock / Unlock 
 
If we click over Lock / Unlock option, we can lock the software window, so, 
we won’t allow to do actions with the installation to non-authorized people. If 
we want to unlock it, we’ll need a password. 
 
When the software is locked, this icon  will appear in the communication 
icons. 
 
 

2.3. Graph 
 
The options of the Graph menu are common to all the graphs that are 

in the program.  
 
However, if we click over the graph and then, we right-click over it 

again, the following menu will appear: 
 

 
 

- Undo zoom: If we want to do a zoom over the graph, we must keep 
pressing the left button of the mouse and then, we must drag the mouse, 
then, a square will appear. Once we have selected the area, we have to 
keep out the left button of the mouse and the zoom will be done. This 
option will display the graph to its initial status, again. 

 
- Print: The displayed area of the graph is printed. 
 
- Plotting method: The graph can be displayed in three different modes: 

- Line (default) 
- Point 
- Point and line 

 
 
 
- Grid lines: It will be selected if the graph is displayed with separation 

lines. There are four options: 
- Both 
- Horizontal 
- Vertical 
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- None (default) 
 
- Grid in front: It must be selected if we want to show the separation lines 

in front of or behind the graph. 
 

2.4. Information 
 

In the Information menu option, there is information about the device 
and program. The following menu will appear: 

 

 
 
   
- Device: A window with controller information and serial number will 

appear (type and version). 
 

 
 
 

- About …: The presentation screen will appear. 
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3. Power Control buttons 
 

Then, there is information about the most common buttons of the 
simulation and supervision screens. 
 

3.1 Events button 
 

In the simulation or supervision, displaying will appear a window 
where the events of a specific day or time period will be showed. 
 
The following window will appear: 
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Buttons: 
 

 Select the time period we want to show. 
 Go back in the time period. 
 Go forward in the time period. 

 Export the data to text file or data base format. See 
Export Button for more information. 

 

3.2. Selection Button 
 
 In the simulation or supervision displaying will appear a window where 
we can select the parameters we want to show in the events graph. 
 
The following screen will appear: 
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We can select different types of parameters: 
- Loads: Loads we have configured in the installation. 
- MR3: Expansion peripherals we have configured in the 

installation. 
- Other: Any other data to display. 

 
Buttons: 
 

 Add to the Show box list the parameter we have selected. 
 Remove from the Show box list the parameter we have 

selected. 
  Priority to display the graph. 

 

3.3. Throughput button 
 
 In the simulation or supervision displaying, will appear a window 
where will be showed the time (percentage) that the installation loads (of 
selected day) have been enabled. 
 
The following screen will appear: 
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In the loads column appears all the installation loads, and in the 
throughput column appears the time percentage of each load. This 
throughput is the selected day in the visualization or supervision 
screen. 
 

3.4. Consumption button 
 

The addition of the energy consumptions (divided by tariffs) will be 
displayed. We can select the period we want to show  in the consumption 
addition. A list will appear with 8 types of tariffs with the target value for each 
tariff and the final consumption in this period for each tariff. 
 
The following screen will appear: 
 

 
 

Buttons:  
 

 Upload the displayed data. It will be enabled when we modify 
the period we want to display. 
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3.5. Export button 
 

It allows exporting the data in the selected period to text or data base 
format. 
 
The following screen will appear: 
 

 
 

- Type of file 
- Text (TXT) 
- MDB (Microsoft Access Data Base) 

 
- Text file: If we select text format this field will be enabled 

- Fixed length register: The registers fields will have the same 
length. 

- Variable length register: The registers fields will have variable 
length and we’ll specify the fields and registers dividers. 

 
- Period: We’ll specify the period of the data we want to export. 


